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The information in this presentation is confidential and proprietary to SAP and may not be disclosed without the 

permission of SAP. This presentation is not subject to your license agreement or any other service or subscription 

agreement with SAP. SAP has no obligation to pursue any course of business outlined in this document or any related 

presentation, or to develop or release any functionality mentioned therein. This document, or any related presentation 

and SAP's strategy and possible future developments, products and or platforms directions and functionality are all 

subject to change and may be changed by SAP at any time for any reason without notice. The information in this 

document is not a commitment, promise or legal obligation to deliver any material, code or functionality.  This 

document is provided without a warranty of any kind, either express or implied, including but not limited to, the implied 

warranties of merchantability, fitness for a particular purpose, or non-infringement.  This document is for informational 

purposes and may not be incorporated into a contract. SAP assumes no responsibility for errors or omissions in this 

document, except if such damages were caused by SAP´s willful misconduct or gross negligence.

All forward-looking statements are subject to various risks and uncertainties that could cause actual results to differ 

materially from expectations. Readers are cautioned not to place undue reliance on these forward-looking statements, 

which speak only as of their dates, and they should not be relied upon in making purchasing decisions.

Legal disclaimer
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SAP Business One 10.0 Enhancements  (1/2) 

Web Client

Web Client for SAP Business One

Financial Management

Drill Down to G/L Accounts in Financial Reports

Posting Periods Enhancements

Extend Journal Entry Remarks to 254 Characters 

and Increase Length of Ref.3 Fields

Financial Management Enhancements

Administration

Support Expiration Date

Enhancements in Document Printing

Referenced Document Enhancements

Support Attachments Tab in Additional Objects

Increased Field Lengths

Enhancements in Approval Process

New Overview Window: Alerts Management

Tab-Level Authorizations in Master Data

Administration Enhancements

Usability

New Skin Style

Enhanced User Interface

Alignment of Form Behavior

User Name in License & Add-On Administration

Usability Enhancements

Localization

New UK (Brexit) Localization

Localization Enhancements

• SAP Note 2826255 - Central Note for SAP Business One 10.0

• SAP Note 2826199 - Central Note for SAP Business One 10.0, version for SAP HANA

Web Client 10.0 Features

https://launchpad.support.sap.com/#/notes/2826255
https://launchpad.support.sap.com/#/notes/2826199
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SnZuekIhPcXGPgvSOj0frg
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Platform | Extensibility

Service Layer Enabled for Microsoft SQL Server

Service Layer Configuration UI

Formatted Search Supports Multiple Triggers

Extend UDF Support to Additional Objects

Microsoft Office 365 Integration

Document Information Extraction

64-bit Support Only

GateKeeper (Browser Access) Service

DI API | Service Layer | Platform | Integration 

Framework Enhancements

SAP Business One 10.0 Enhancements  (2/2) 

Project Management

Interactive Gantt Chart

Sales | Purchasing | Service

Backorder Report Enhancements

Printing Service Calls & Contracts

Hide Blank Lines in Addresses

Add Button Extended in Marketing Documents

Enhanced Open Items List Report

EU PEPPOL E-Invoicing

Sales | Purchasing | Service Enhancements

Production

Bill of Materials (BoM) Description Enhancements

Drill Down from BoM to Item Master Data

Production Enhancements

Inventory | Distribution

Serial & Batch Numbers Management

Ability to change UoM Group of an item

Inventory | Distribution Enhancements 

Web Client 10.0 Features

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SnZuekIhPcXGPgvSOj0frg
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG


Web Client
SAP Business One 10.0 (MS SQL) PL02 Update

SAP Business One 10.0, version for SAP HANA
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▪ The Web Client* is based on SAP Fiori 

design principles encapsulating SAP 

Business One core processes and business 

logic alongside an advanced user experience

▪ Focused on creation, processing and 

updating of Sales Quotations, Sales Orders, 

A/R Deliveries, and A/R Invoices (PL01)

▪ List views for purchasing documents (PL02)

▪ Supports creation and update of Items, 

Business Partners, and Activities 

▪ The Web Client provides some sophisticated 

analytic charting capabilities

▪ For optimized user experience launch the 

Web Client in either a desktop computer or 

tablet, using the Google Chrome or Firefox 

web browser. The Web Client can also be 

launched directly from the regular SAP 

Business One desktop application.

Web Client for SAP Business One
For details check the SAP Business One 10.0 Top ReSolutions document

* The Web Client delivered with SAP Business One 10.0 PL02 is supported by all SAP Business One localizations. Brazil and India in view mode only.

Web Client 

PL02 Update

https://help.sap.com/doc/542eec5fd4454d988ce8fb0ebbcd8437/10.0/en-US/SAP_Business_One_10_TopResolutions.pdf
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SnZuekIhPcXGPgvSOj0frg


Usability
SAP Business One 10.0
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New Skin Style - Belize Deep

Benefit
▪ Modern and fresh look and feel

▪ Harmonized user-experience for those who work with 

both SAP Business One and the Web Client

Feature
▪ New skin style “Belize Deep” is added to SAP 

Business One 10.0, version for SAP HANA.

▪ Inspired by the SAP Fiori design and following the 

Web Client look & feel

▪ Currently available when using the Fiori-Style 

Cockpit

▪ 4K monitors supported when using the Belize Deep 

skin style

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Enhanced User Interface

Benefit
▪ Information about current company and logged-on 

user is displayed clearly

▪ Switching between company databases and users is 

one-click away

Feature
▪ New icon and menu option under the View menu 

enables the showing or hiding of the toolbar

▪ Users can enlarge working area by hiding the toolbar

▪ The company name and user name are clearly 

displayed at the top center of SAP Business One 

window; Click it to open the “Choose Company” 

window directly

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Alignment of Form Behavior

Feature
▪ Ability to resize and maximize form size is 

supported in: 

Company Details, General Settings, Posting 

Periods, Print Preferences, Checks for Payment, 

Document Generation Wizard, Update Special 

Prices Globally, Trial Balance Revaluation, General 

Ledger, Layout and Sequence, Request for 

Generation Approval, Approval Stages, Export 

Transactions to SAP Business One, Payment 

Methods, Payment Terms, Query Authorization 

Groups, Report and Layout Manager, UDF - Field 

Data, Configuration Management, Cash Flow, Add-

on Manager

Benefit
▪ Increased usability by avoiding scrolling, especially 

in busy forms

▪ Alignment with standard system form behavior

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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User Name in License & Add-On Administration

Benefit
▪ Enhanced clarity and transparency of the user's 

identity by displaying the user name supports accurate 

license allocation and add-on administration

Feature
▪ A new column for displaying the User Name is 

added to the Allocation and Assignment tabs in 

License Administration window and to the User 

Preferences tab in Add-on Administration 

window

▪ Filtering according to User Name field is now 

possible within both forms

▪ Sorting by User Name is supported in the License 

Administration window

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Usability

Feature Description Localization

Hide Locked User A new checkbox ‘Hide Locked User’ is available in the Add-on 

Administration, UI Configuration Template, Alerts Management, and Copy 

Form Settings (Users – Setup) windows.

SAP Note 2970933 (FP2011)

All

Add Queries to SAP Business One 

Menu

Queries can be added to the SAP Business One menu via the Query 

Manager window choosing the Assign to Menu option. In the Query Menu 

Registration window select the Menu Item checkbox and specify the 

details where this query should be positioned. 

The display of the query is related to the user’s authorization.

SAP Note 2970958 (FP2011)

All

Import User-Defined Tables (UDT) 

from Microsoft Excel

User-Defined Tables (UDT) can be imported from Microsoft Excel. In the 

Data Type to Import dropdown list the entry User-Defined Tables is 

available based on the UDT form authorization.

SAP Note 2970949 (FP2011)

All

FP2011 Update

https://launchpad.support.sap.com/#/notes/2970933
https://launchpad.support.sap.com/#/notes/2970958
https://launchpad.support.sap.com/#/notes/2970949


Administration
SAP Business One 10.0
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Support Expiration Date

Feature
▪ The information Support Expiration Date is shown in 

the About SAP Business One window

▪ Version Name in About window is changed to 

quarterly release cycle (FP2008)

See SAP Note 2957553

Benefit
▪ Simplifies support by having necessary 

information available in one screen

FP2008 Update

https://launchpad.support.sap.com/#/notes/2957553
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Enhancements in Document Printing

Feature
▪ The selection criteria for document printing is 

enriched with additional options according to the 

selected document type

▪ Form Settings window is added to the “Print 

<document>” window allowing the user to customize 

the column display

▪ The “Print <document>” window now supports table 

sorting and filtering

Benefit
▪ The enhanced selection criteria enables you to 

optimize batch printing 

▪ Increased usability and productivity especially 

when printing a high number of documents 

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Referenced Document Enhancements

Feature
▪ You are now able to reference documents in Checks For Payment, 

Purchase Request, Goods Receipt & Issue, Inventory Transfer 

Request, and Inventory Transfer

▪ Numeric indication for number of referenced documents

▪ Automatic referenced document creation from applicable marketing 

documents

▪ Recurring Postings can be referenced to a single document. This 

document contains a reference to each recurring posting created. 

The referenced by tab displays then the cross referencing to the 

recurring posting itself.

▪ Module-sorted list of documents to reference

▪ Document Referencing is available for Incoming and Outgoing 

Payments, Inventory Revaluation, Inventory Counting, and Inventory 

Posting (FP2008) - SAP Note 2945089

▪ When duplicating a document, a reference between the original and 

duplicated document can be created (FP2011) - SAP Note 2958941

Benefit
▪ Extended coverage of referenced documents across 

SAP Business One modules

▪ Better visibility of when documents are referenced

FP2008 Update

FP2011 Update

https://launchpad.support.sap.com/#/notes/2945089
https://launchpad.support.sap.com/#/notes/2958941
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Support Attachments Tab in Additional Objects

Feature
▪ The Attachments Tab is now available in Inventory 

Opening Balance*, Inventory Counting, Inventory 

Posting*, Incoming Payments*, Outgoing 

Payments*, Check for Payments*, Deposit, Journal 

Entry, Production Order, and Time Sheet*

▪ *Due to the addition of the Attachments tab, the 

Contents tab now holds the original details of 

the form/General tab

Benefit
▪ Support managing attachments for additional 

objects and streamline system behavior

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Field Length Increase

Benefit
▪ More flexibility for the values entered in these fields

▪ Standardization of product field definitions

Feature
▪ Customer Group Name and Supplier Group Name may 

contain up to 100 characters

▪ The Item Group Name also supports 100 characters

▪ The length of the Item Description field in the Item 

Master Data window is 200 characters (FP2008)

See SAP Note 2949632

▪ The field length of Industry Name is 40 characters and 

of Industry Description is 120 characters (FP2008)

See SAP Note 2931333

FP2008 Update

https://launchpad.support.sap.com/#/notes/2949632
https://launchpad.support.sap.com/#/notes/2931333
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Enhancements in Approval Process

Benefit
▪ Minimizes unnecessary back and forth between 

authorizer and originator

▪ Simplifies approval procedures and adds even 

more flexibility

Feature
▪ New setting enables approvers to update draft 

document in Pending status

▪ Last Updated By and Last Updated On fields are 

now available within the Request for Generation 

Approval form

▪ Approval Status Report now contains Draft 

Updated By, Draft Update Date, Draft Update 

Time, and Draft Remarks fields

▪ Both the authorizer and the originator can add the 

document for approval

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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New Overview Window: Alerts Management

SAP Note 2945182

Benefit
▪ Simplifies alerts management

▪ Better overview on existing alerts

Feature
▪ New window Alerts Management available

▪ Overview of system and user alerts

▪ Filter option

▪ Actions button to create:

▪ New user alerts

▪ Set alerts to active or inactive

▪ Remove alerts

FP2008 Update

https://launchpad.support.sap.com/#/notes/2945182
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Tab-Level Authorizations in Master Data Records

Benefit
▪ Enables the granting of more accurate 

authorizations to each user, based on tasks and 

responsibilities

▪ Helps to prevent human errors and increases data 

protection 

▪ Increases productivity

Feature
▪ Different authorizations can be granted to different 

tabs in Business Partner Master Data and Item 

Master Data

▪ If a user has no authorization for a given tab, this 

tab will be automatically hidden

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Administration

Feature Description Localization

Change Log Window Enhancements New columns “Created On/At” and “Updated On/At” are added to the 

Change Log window to see the specific date and time.

SAP Note 2957436 (FP2008)

All

Manually Entering Paths Paths can be manually entered or pasted on the Path tab in the General 

Settings window.

SAP Note 2949641 (FP2008)

All

Shipping Types Deactivation New checkbox Active is available in the Shipping Types window under 

Administration → Setup → Inventory → Shipping Types to activate or 

deactivate shipping types. 

SAP Note 2950719 (FP2008)

All

FP2008 Update

https://launchpad.support.sap.com/#/notes/2957436
https://launchpad.support.sap.com/#/notes/2949641
https://launchpad.support.sap.com/#/notes/2950719
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Administration

Feature Description Localization

Warning Message When Choosing 

‘Personal Blocking’

When choosing Personal Data Blocking in the Personal Data 

Management Wizard a warning message is displayed if the BP Balance 

amount is not zero.

SAP Note 2946064 (FP2011)

All

Authorization for ‚Copy Table‘ 

Function

In the General Authorizations a new authorization Copy Table is available 

with Full Authorization and No Authorization.

In new installations and after upgrades the default setting for the Copy 

Table authorization is Full Authorization; for new users, No 

Authorization is selected by default.

SAP Note 2970937 (FP2011)

All

Configure License Balloon 

Appearance

A new checkbox Show License Information at Startup is added to the 

Users – Setup window -> Services tab to set whether the license balloon 

will be displayed after logging in. 

The checkbox is reset to default (balloon is displayed):

- Every 3 months / 90 days

- When upgrading to a higher patch or release

SAP Note 2970959 (FP2011)

All

FP2011 Update

https://launchpad.support.sap.com/#/notes/2946064
https://launchpad.support.sap.com/#/notes/2970937
https://launchpad.support.sap.com/#/notes/2970959
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Administration

Feature Description Localization

Enhancement of Check on Duplicate 

Customer/Vendor Reference Number

Under Administration → System Initialization → Document Settings →

Per Document tab, select a sales or purchasing document type, under 

When Duplicated Customer Reference No. Occurs:

When selecting Warning Only or Block Release/Receipt the following 

options are available:

- Check for Duplicate Under

o Individual Customer Only

o All Customers

- Check for Duplicate in Current Fiscal Year Only

SAP Note 2970936 (FP2011)

All

FP2011 Update

https://launchpad.support.sap.com/#/notes/2970936
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Administration

Feature Description Localization

Authorization to Remove Opportunity Authorization is required for new users to remove an opportunity.

Assign authorization under Administration -> System Initialization -> 

Authorizations -> General Authorizations -> Opportunities -> Special 

Opportunity Authorizations -> Remove Opportunity

SAP Note 2985725 (FP2102)

All

Authorization to View Other Users’ 

Payment Drafts in Payments Draft 

Report

Regular users can view incoming and outgoing payment drafts created by 

other users respectively, if the following two authorizations are given:

- View Incoming Payment Drafts Created by Other Users

- View Outgoing Payment Drafts Created by Other Users

Define Authorizations under Administration -> System Initialization -> 

Authorizations -> General Authorizations -> Banking -> Outgoing 

Payments -> Payments Drafts Report

SAP Note 2990653 (FP2102)

All

Copy Selected Forms Between Users An admin user is able to copy selected forms' settings from one user to 

another.

SAP Note 2979530 (FP2102)

All

FP2102 Update

https://launchpad.support.sap.com/#/notes/2985725
https://launchpad.support.sap.com/#/notes/2990653
https://launchpad.support.sap.com/#/notes/2979530
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Administration

Feature Description Localization

Access to Change Log for User with 

Read-Only Authorization for Specific 

Object

Users with full authorizations for Change Log and read-only authorizations 

for the following documents can view their change logs:

- Sales and purchasing documents

- Journal Entries

- Goods Issues, Goods Receipts, Receipts from Production, and Issues 

for Production

- Inventory Transfers and Inventory Transfer Requests

- Inventory Opening Balances, Inventory Counting, and Inventory 

Postings

- Incoming Payments and Outgoing Payments

SAP Note 2303812 (FP2102)

All

FP2102 Update

https://launchpad.support.sap.com/#/notes/2303812


Financial Management
SAP Business One 10.0
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Drill Down to G/L Account in Financial Reports

Benefit
▪ Direct access to account details and account balance 

of relevant accounts increases usability and 

transparency 

▪ Streamlined with standard system behavior 

Feature
▪ Golden arrows are added next to the account 

codes in financial reports allowing users to drill 

down into the account record within the Chart of 

Accounts 

▪ Available in Balance Sheet, Trial Balance, and 

Profit and Loss Statement

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Posting Periods Enhancements

Benefit
▪ Simplifies and streamlines the creation of new 

financial periods 

▪ Enhanced usability of the Posting Periods table, 

highly significant for businesses with long list of 

posting periods

Feature
▪ A new checkbox added to the Posting Periods 

window enables to define the default “Due Date To” 

to be set when creating new posting periods

▪ The sorting of columns is now possible within the 

Posting Periods form

▪ Filtering is now possible within the Posting Periods 

form

▪ The Find field allows for quick free-text searching

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Extend Journal Entry Remarks to 254 Characters and 

Increase Length of Ref. 3 Fields 

Benefit
▪ Allows to enter more detailed information related to 

the journal entry 

▪ The alignment with Remarks field size in marketing 

documents fully supports setting it as reference 

fields, while previously, remarks >50 characters 

would cut-off when copied to the Remarks in Journal 

Entry

Feature
▪ The Remarks field in Journal Entry is extended and 

may contain up to 254 characters

▪ The length of the Ref. 3 fields in the header and 

rows are increased to 100 characters (FP2008)

See SAP Note 2949589

FP2008 Update

https://launchpad.support.sap.com/#/notes/2949589
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Financial Management

Feature Description Localization

Warn Message Before Adding Manual 

Journal Entries

When adding a manual Journal Entry a system message appears to warn 

that journal entries cannot be changed after adding them.

SAP Note 2923187 (FP2008)

All

FP2008 Update

https://launchpad.support.sap.com/#/notes/2923187
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Financial Management

Feature Description Localization

Updating Reference Field in Journal 

Entries with Locked Posting Periods

Update of the Remarks, Ref1, Ref2, Ref3, and User-Defined Fields in journal 

entries with locked posting periods is enabled.

SAP Note 2968895 (FP2011)

All

Bank Statement Processing (BSP) 

Enhancements

In the Bank Statement Row – Details: Expanded window, for bank statement 

rows whose posting method is Business Partner from/to Bank Account:

- Distribution rules can be defined

- Sales and purchase orders can be added using the Add Open 

Documents window. BSP will create down payment invoices or requests 

based on the orders

In the Bank Statement Details window:

- For bank statement rows whose posting method is Business Partner 

from/to Bank Account, and for which any document is selected, the control 

account can be defined

- When you have selected the checkbox No Validation for Starting/Ending 

Balance in the House Bank Accounts - Setup window, the bank statement 

can be finalized even if the difference does not equal zero; and the starting 

balance of your current bank statement can be different to the ending 

balance of the previous one

See more details in SAP Note 2980038 (FP2011)

All

FP2011 Update

https://launchpad.support.sap.com/#/notes/2968895
https://launchpad.support.sap.com/#/notes/2980038
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Financial Management

Feature Description Localization

Bank Statement Processing (BSP) 

Enhancements

In the Bank Statement Row – Details: Expanded window, the values in 

the Applied Amt - Payment Currency column can be updated.

In the Bank Statement Details window, order currency can be different from 

the local currency. 

See more details in SAP Note 3031178 (FP2102)

All

FP2102 Update

https://launchpad.support.sap.com/#/notes/3031178


Localization
SAP Business One 10.0
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New UK (Brexit) Localization

Benefit
▪ Smooth transition from pre-Brexit GB Localization to the 

new UK Localization

Feature
▪ New localization introduced for United Kingdom of 

Great Britain and Northern Ireland to support post-

Brexit

▪ In this localization Make Tax Digital and Extended 

Tax Reporting are set by default

▪ See SAP Note 2519116

▪ Localization Migration Utility (FP2008)

See SAP Note 2912598

FP2008 Update

https://launchpad.support.sap.com/#/notes/2519116
https://launchpad.support.sap.com/#/notes/2912598
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Localization

Feature Description Localization

„Country“ Field Labels Changed to 

„Country/Region“

Country field labels are changed to Country/Region.

SAP Note 3021987 (FP2102)

All

Country/Region Setup 

Enhancements to Support ISO 3166 

Country Codes

The Country/Region fields are populated based on the official ISO 3166 

country codes in the Countries/Regions – Setup window. 

SAP Note 3019691 (FP2102)

All

FP2102 Update

https://launchpad.support.sap.com/#/notes/3021987
https://launchpad.support.sap.com/#/notes/3019691


Sales | Purchasing | Service
SAP Business One 10.0
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Backorder Report Enhancements

Benefit
▪ All A/R Reserve Invoices are visible within the 

Backorder Report

Feature
▪ Backorder Report now displays A/R Reserve 

Invoices with payment status Fully Paid, Partially 

Paid and Not Paid

▪ Reserve Invoice Payment Status is included within 

the Filter Table

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Printing Service Calls and Contracts

Benefit
▪ Preference settings on Service Calls and Service 

Contract printing/emailing

▪ Bulk processing of service calls and service contracts

Feature
▪ Print Preferences are now available for both 

Service Calls and Service Contracts

▪ Document Printing includes Service Calls and

Service Contract allowing for bulk document 

distribution

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Hide Blank Lines in Addresses

Benefit
▪ Enhanced formatting of the printed, previewed, or PDF 

document 

▪ Easier readability for users within marketing document 

forms, especially when address format consists of 

multiple components

Feature
▪ A new checkbox within the Address Formats - Setup 

window allows the hiding of empty address lines

▪ When selected, ship-to and bill-to addresses in  

future marketing documents appears without empty 

lines 

▪ This setting also applies to print layouts for marketing 

documents defined in Crystal Reports – i.e. empty 

lines in addresses will also be hidden in the printed 

documents

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Add Button Extended in Marketing Documents
SAP Note 2878515

Benefit
▪ More flexibility in document creation and better 

handling for users

Feature
▪ The Add button in sales and purchase document 

creation is enhanced

▪ Additionally to the previous common behavior 

(i.e. after creating and adding a document, the 

window closes and a new window opens), the 

following options are now available:

▪ Add & New: Document is added and a new window opens

▪ Add & View: Document is added and is displayed

▪ Add & Close: Document is added and window closes

▪ The user's last choice will be remembered for the 

given document for the next time

PL01 Update

https://launchpad.support.sap.com/#/notes/2878515
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Enhanced Open Items List Report
SAP Note 2878483

Benefit
▪ Easier handling due to more document options and 

information in one report

Feature
▪ The Open Items List report includes more 

document information:

Owner, Sales Employee/Buyer, Remarks, Approved, 

Created by, Contact Person, Payment Terms, BP 

Project, UDFs in document headers

▪ The report offers the possibility to close and cancel 

multiple documents. This feature is supported for 

these document types:

Sales Quotation, Sales Order, Purchase 

Request, Purchase Quotation, Purchase Order

▪ In the report multiple Return Requests and Goods 

Return Request documents can be closed

PL01 Update

https://launchpad.support.sap.com/#/notes/2878483
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EU PEPPOL E-Invoicing

Feature
▪ International electronic invoicing platform with a set of 

rules and specifications that enables electronic 

communications with any European government institution 

for procurement processes. 

▪ Electronic documents are sent and received through 

registered service providers

▪ See more details and local specifics for PEPPOL protocol 

in SAP Note 2915144

▪ General information on PEPPOL integration for the EU in 

SAP Note 2669994

▪ Due to own specific electronic invoicing functionality, 

following localizations don’t support PEPPOL at that time:

Argentina, Brazil, Costa Rica, Guatemala, India, and 

Mexico 

Benefit
▪ Creation and import of documents in electronic format

PL02 Update

https://launchpad.support.sap.com/#/notes/2915144
https://launchpad.support.sap.com/#/notes/2669994
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Sales | Purchasing | Service

Feature Description Localization

Editing UDFs in Document Rows 

After the Document was Added or 

Closed

A new setting in the Document Settings "Allow Update of User-Defined 

Fields When Document Rows Are Not Editable" gives the possibility to 

make UDFs editable independently of the document/row status.

New authorization controls user's ability to edit UDFs on marketing 

document rows. 

SAP Note 2872368 (PL01)

All

Display Business Partner Address 

UDF with Marketing Document 

Address User Defined Fields

Business Partners – Addresses UDFs can be viewed and updated in

• Address Component window on Logistics tab in marketing documents

• Address Component window on Business Partner tab of Service Calls

• Address Formats – Setup window

See the Compatibility Issues in SAP Business One 10.0

SAP Note 2872353 (PL01)

All

PL01 Update

https://launchpad.support.sap.com/#/notes/2872368
https://help.sap.com/http.svc/rc/6cad63bcfa5942ffb3a0d6cb10d7c0a2/10.0/en-US/Compatibility_Issues_in_SAP_Business_One.pdf
https://launchpad.support.sap.com/#/notes/2872353
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Sales | Purchasing | Service

Feature Description Localization

Create QR Codes QR (Quick Response) codes can be created on print layouts of marketing 

documents. New field Create QR Code From is available in Accounting

tab of marketing documents.

An API service and a free open source library are available for partners to 

create QR codes. 

SAP Note 2889899 (PL02)

All

Adding Multiple Business Partners to 

One Equipment Card

Multiple business partners can be added to an equipment card. 

SAP Note 2906168 (PL02)

All

Updating Group Number The Group No. on purchase quotations can be changed to the next 

sequential number in the predefined series.

SAP Note 2896569 (PL02)

All

PL02 Update

https://launchpad.support.sap.com/#/notes/2889899
https://launchpad.support.sap.com/#/notes/2906168
https://launchpad.support.sap.com/#/notes/2896569
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Sales | Purchasing | Service

Feature Description Localization

Copying Manual Remarks Under Administration → System Initialization → Document 

Settings → General tab → Document Remarks Include section 

a new option Manual Remarks Only is available.

With this option, when using ’Copy To’ to copy a base sales, purchasing 

or inventory document, the ’Remarks’ field in the target document will only 

include the remarks entered by users in the source document, excluding 

the ’Base Document Number’ or the ’Business Partner Reference 

Number’.

SAP Note 2931961 (FP2008)

All

Copy Attachments from Base 

Document to Target Document

Under Administration → System Initialization → Document 

Settings → General tab enable checkbox ‘Attachments from Base 

Document to Target Document’ to copy documents attachments.

SAP Note 2923323 (FP2008)

All

Item Description is Exposed in 

Alternative Items Window

The column Item Description is exposed in the Alternative Items window.

SAP Note 2955529 (FP2008)

All

New Checkbox ‘Duplicate Bar Codes 

While Duplicating Items’

A new checkbox Duplicate Bar Codes While Duplicating Items available 

under Administration → System Initialization → General Settings → 

Inventory → Item tab.

SAP Note 2928480 (FP2008)

All

FP2008 Update

https://launchpad.support.sap.com/#/notes/2931961
https://launchpad.support.sap.com/#/notes/2923323
https://launchpad.support.sap.com/#/notes/2955529
https://launchpad.support.sap.com/#/notes/2928480
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Sales | Purchasing | Service

Feature Description Localization

Document Status “E-Mailed” Display status ‘Open; E-Mailed’ and ‘Open; Printed and E-Mailed’ in sales 

documents, purchase documents, and inventory transfer requests when 

the document was sent by e-mail.  

SAP Note 2924241 (FP2008)

All

Recurring Transaction Templates 

Selection Criteria Window 

When opening the ‘Recurring Transaction Templates’ the ‘Selection 

Criteria’ window opens to filter the templates.

SAP Note 2939185 (FP2008)

All

Recurring Transaction Templates

Recurrence Period Enhancement

‘Recurrence Period in Recurrence Transaction Templates’ supports the 

options ‘Every 2 Weeks’ and ‘Every 2 Months’.

SAP Note 2939183 (FP2008)

All

Consider Prices Before Discount 

Group as Effective Price

Consider prices before discount group as effective price when adding 

marketing documents.

SAP Note 2905325 (FP2008)

All

Cancelation of Return Request and 

Goods Return Request

‘Return Request’ and ‘Goods Return Request’ can be canceled.

SAP Note 2928911 (FP2008)

All

FP2008 Update

https://launchpad.support.sap.com/#/notes/2924241
https://launchpad.support.sap.com/#/notes/2939185
https://launchpad.support.sap.com/#/notes/2939183
https://launchpad.support.sap.com/#/notes/2905325
https://launchpad.support.sap.com/#/notes/2928911
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Sales | Purchasing | Service

Feature Description Localization

Update Consolidating Business 

Partner and Consolidation Type on 

Document Level

View and update the consolidation business partner and consolidation 

type on the Accounting tab is enabled. The default values are taken from 

the business partner master data and values cannot be changed after the 

documents are added. This is enabled for the following documents:

- A/R Invoice, A/R Reserve Invoice, A/R Credit Memo, A/R Down 

Payment Invoice (all localizations except CZ, SK, HU, PL, RU, UA) 

Delivery, Return

- A/P Invoice, A/P Reserve Invoice, A/P Credit Memo, A/P Down 

Payment Invoice (all localizations except CZ, SK, HU, PL, RU, UA), 

Goods Receipt PO, Goods Return

The consolidating business partner and consolidation type of the 

documents generated with the following tools and methods are taken from 

the base documents and not from the business partner master data:

- Document Generation Wizard

- Payment Wizard

- Billing Wizard

- Copy to

- Copy From

SAP Note 2980002 (FP2011)

All

FP2011 Update

https://launchpad.support.sap.com/#/notes/2980002
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Sales | Purchasing | Service

Feature Description Localization

Items Associated with Canceled 

Procurement Documents are 

Displayed in the Procurement 

Confirmation Wizard

Items in a sales order / sales quotation / production order associated with 

canceled procurement documents are displayed in the Procurement 

Confirmation Wizard

SAP Note 1804907 (FP2102)

All

Set Default Business Partner Catalog 

Number

On the BP tab or the Items tab in the Business Partner Catalog Numbers 

window a user can select a Business Partner Catalog Number as the 

default for each item from the BP tab, or for each business partner from 

the Items tab.

SAP Note 3007312 (FP2102)

All

Hide Inactive Contact Person in 

Business Partner Master Data

A new checkbox Display Inactive Contact Persons in Business Partners 

Master Data is added to the General Settings → BP tab.

This checkbox can be used to determine whether to display inactive 

contact persons on the Business Partner Master Data → Contact 

Persons tab.

SAP Note 3009497 (FP2102)

All

FP2102 Update

https://launchpad.support.sap.com/#/notes/1804907
https://launchpad.support.sap.com/#/notes/3007312
https://launchpad.support.sap.com/#/notes/3009497
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Sales | Purchasing | Service

Feature Description Localization

Link Between Contact Persons and 

Business Partner's Addresses

With the new dropdown list Connected Address on the Contact 

Persons tab of the Business Partner Master Data, it is possible to link the 

business partner’s existing

- Bill to

- Pay to

- Ship to

address to the selected contact person.

SAP Note 2979550 (FP2102)

All

FP2102 Update

https://launchpad.support.sap.com/#/notes/2979550


Project Management
SAP Business One 10.0
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Interactive Gantt Chart

Benefit
▪ Project updated according to planning changes 

within interactive Gantt Chart

▪ Easier and more visual planning of Project 

Management Tasks

Feature
▪ Interactive Gantt Chart allows Project Phases to be 

moved or extended/shortened interactively

▪ New fields added representing Project Due Date and 

Finish Date

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG


Inventory | Distribution
SAP Business One 10.0



54PUBLIC© 2021 SAP SE or an SAP affiliate company. All rights reserved.  ǀ

Serial & Batch Numbers Management 

Benefit
▪ More document options when updating Serial 

Numbers and Batches

▪ Better reporting on warehouse code on warehouse 

name on inventory transfer transactions 

Feature
▪ Serial Number Management and Batch Management

now includes the ability to update on A/R Reserve 

Invoices and Inventory Transfer Requests

▪ Destination Warehouse Code and Destination 

Warehouse Name now included in the Serial 

Number / Batch Management Update form

▪ New reports available (PL01):

▪ Forward Batches and Serials Trace Report 

▪ Reverse Batches and Serials Trace Report 

▪ See SAP Note 2877541

PL01 Update

https://launchpad.support.sap.com/#/notes/2877541
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Support Changing UoM Group in Item Master Data

Benefit
▪ More flexibility in changing UoM group 

relationships for Item Master data

Feature
▪ Unit of Measure Groups may now be changed on 

an Item Master Data record

▪ To do this the new UoM Group must have at least 

the identical set of conversion rules as the original 

UoM Group

▪ Only need to “zero down”/close open documents 

on changed item UoM Groups definitions

▪ Set UoM in its UoM Group to Active (PL01)

See SAP Note 2878890

PL01 Update

https://launchpad.support.sap.com/#/notes/2878890
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Inventory | Distribution

Feature Description Localization

Last Prices Report in Item Master 

Data

Last Prices Report can be opened in the Item Master Data window.

SAP Note 2979973 (FP2011)

All

Display Preferred Vendor Name in 

Item Master Data

The Preferred Vendor Name is displayed in the Item Master Data -> 

Purchasing Data tab. 

SAP Note 2970897 (FP2011)

All

Sales/Purchase Item in Item Master 

Data can be Deselected

When an item that is a component of another item in a bill of material 

(BOM) the option Sales Item or Purchase Item can be deselected.

SAP Note 1329054 (FP2011)

All

FP2011 Update

https://launchpad.support.sap.com/#/notes/2979973
https://launchpad.support.sap.com/#/notes/2970897
https://launchpad.support.sap.com/#/notes/1329054


Production
SAP Business One 10.0
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Bill of Materials (BoM) Description Enhancements

Benefit
▪ Item master data record descriptions updated 

accordingly within the associated Bill of Materials

▪ Flexible handling of item and resource descriptions in 

Bill of Materials

Feature
▪ Item Description update in the item master 

data connected to Bill of Materials parent item will 

be reflected in the Bill of Materials Product 

Description

▪ The item and resource descriptions are editable in 

Bill of Materials and Production Order Components. 

Additionally, the Item Description can be updated via 

DI API (PL01)

See SAP Note 2872529

PL01 Update

https://launchpad.support.sap.com/#/notes/2872529
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Drill Down from BoM to Item Master Data

Benefit
▪ More intuitive and direct navigation between Bill of 

Materials and Item Master Data

▪ Flexibility within navigation due to system prompt of 

navigation choice

Feature
▪ Direct “drill-down” to Item Master Data record now 

possible from the Parent Item Number 

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG


60PUBLIC© 2021 SAP SE or an SAP affiliate company. All rights reserved.  ǀ

Production

Feature Description Localization

Production Orders as Base 

Document in Procurement 

Confirmation Wizard

Production Order can be selected as Base Document in the Procurement 

Confirmation Wizard.

SAP Note 2945172 (FP2008)

All

Edit Closed or Canceled Production 

Orders

When a Production Order is closed or canceled, the following fields will be 

editable:

- Remarks on the form footer

- Pick and Pack Remarks on the form footer

- Reference Document on the Summary tab

- Attachments on the Attachments tab

- User-Defined Fields on Production Order – Title and on Production 

Order - Rows

SAP Note 2920833 (FP2008)

All

Delete Bill of Materials (BOM) en

Masse

Bill of Materials (BOM) can be deleted en masse from Bill of Materials 

Management.

SAP Note 2926091 (FP2008)

All

FP2008 Update

https://launchpad.support.sap.com/#/notes/2945172
https://launchpad.support.sap.com/#/notes/2920833
https://launchpad.support.sap.com/#/notes/2926091
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Production

Feature Description Localization

Hidden BOM Components are Not 

Printed on SAP Crystal Reports

Defined ’Hide BOM Components in Printout’ are not printed using SAP 

Crystal Report layouts.

SAP Note 2319313 (FP2102)

All

FP2102 Update

https://launchpad.support.sap.com/#/notes/2319313


Platform | Extensibility
SAP Business One 10.0
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Service Layer Enabled for Microsoft SQL Server

Benefit
▪ Ready for loosely coupled extensibility running for 

MSSQL and HANA

Feature
▪ Built on core protocols such as HTTP and OData

▪ Highly scalable (parallel-processing)

▪ High availability (load balancing)

PL01 Update
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Service Layer Configuration UI

Benefits
▪ No need to edit multiple configuration files

Feature
▪ New System Landscape Directory URL for Service 

Layer configuration 

▪ https://<hana-server>:<sld-

port>/ServiceLayerController

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Formatted Search Supports Multiple Triggers 

Benefit
▪ More possibilities and flexibility when implementing 

formatted searches/user defined values

Feature
▪ User Define Values support multiple triggers

+ + + +=

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Extend UDF Support to Additional Objects

Benefit
▪ More possibilities in quick solution 

customizing

Feature
▪ User Defined Fields can be added to more SAP 

Business One 10.0 objects*

▪ *Alerts (OALT), Attachment rows (ATC1), 

Countries (OCRY), Document Numbering Series 

(NNM1), BP Groups (OCRG), BP Payment Terms 

(OCTG), BP/Item Properties (OCQG)/(OITG), Item 

Preferred Vendors (ITM2), Item Prices (ITM1), 

Manufacturers (OMRC), UoM Master Data 

(OUOM), Location (OLCT), Package Types 

(OPKG), Branch Setup (OBPL), and Shipping 

Types (OSHP)

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Microsoft Office 365 Integration

Benefit
▪ Automatic upload of exports into OneDrive

▪ Easier report and document layouts management

▪ Access from everywhere

Feature
▪ Microsoft Office 365 and OneDrive integration 

allows for document layouts, grid results and reports 

to be exported into Excel and Word accordingly

▪ SAP Business One 10.0 Template Management 

allows for more flexibility in reporting and document 

layouts management

▪ Microsoft Office 365 integration starting with SAP 

Business One Cloud 1.1 PL17 (FP2102)

See SAP Note 3018885

FP2102 Update

https://launchpad.support.sap.com/#/notes/3018885
https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Document Information Extraction

Benefit
▪ Automatic generation of A/P invoice drafts out of PDFs

▪ Let employees save work time and focus on new 

activities

Feature
▪ Scanning PDF documents and extract invoice header 

and item information 

▪ Create A/P invoice in SAP Business One

▪ See SAP Note 3021904

FP2102 Update

https://launchpad.support.sap.com/#/notes/3021904
https://www.youtube.com/watch?v=J6HoX9fFVC4
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64-bit Only Support

Benefit
▪ Smaller software package downloads (due 

to removal of redundant 32-bit executables)

64-bit

Feature
▪ SAP Business One will support only 64bit 

Windows operating system 

▪ Only 64-bit add-ons will be supported with 

SAP Business One 10.0 

https://www.youtube.com/playlist?list=PLMdHXbewhZ2SPRH1lMtwxXycl3DHv8zSG
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Gatekeeper (Browser Access) Service

Benefit
▪ Easy access

▪ No local client is needed

Feature
▪ SAP Business One Client UI is rendered 

and published via gatekeeper service over 

the HTTPS protocol

PL01 Update
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Platform & Extensibility

Feature Description Localization

SAP HANA 2.0 Platform Adaption SAP HANA 2.0 supported only All

Support SLES 15 Suse Linux Enterprise Server SLES 15 only All

SAP HANA 2.0 Platform Adaption 

for Remote Support Platform 3.2

RSP 3.2 supports SAP HANA 2.0 All

Integration Framework for SAP 

Business One

SAP Business One integration for 

SAP NetWeaver

Additional System Types in System Landscape Directory available:

SAP Business One 10.0

SAP Business One Generic

S/4 HANA on Premise

SAP Note 2857220

All

DI API:

Blocking Updating Address ID in 

Business Partner Master Data 

through DI API

New checkbox Allow to Update Address ID added to the Administration -> 

System Initialization -> General Settings -> BP tab.

This checkbox is selected by default.

When deselecting the checkbox the Address ID field cannot be edited and 

updated through DI API; an error message appears.

All

See also the SAP Business One Platform Support Matrix (MS SQL / SAP HANA)

https://launchpad.support.sap.com/#/notes/2857220
https://help.sap.com/doc/011000358700000032462013e/latest/en-US/B1_Platform_Support_Matrix.pdf
https://help.sap.com/doc/011000358700000239412011e/latest/en-US/B1_HANA_Platform_Support_Matrix.pdf
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Platform & Extensibility PL01 Update

Feature Description Localization

DI API and Service Layer:

Recurring Postings

Recurring Postings exposed to DI API and Service Layer

SAP Note 2878517 (PL01)

All

DI API and Service Layer:

Posting Template

Posting Templates exposed to DI API and Service Layer

SAP Note 2878484 (PL01)

All

DI API and Service Layer:

Cancel and Restore Approval 

Requests

New methods added to cancel and restore Approval Requests in DI API 

and Service Layer

SAP Note 2859177 (PL01)

All

DI API:

Additional Reference Documents

Additional document referencing for

Goods Receipt, Goods Issue, Purchase Request, Inventory Transfer, 

Inventory Transfer Request, Checks for Payment

SAP Note 2866114 (PL01)

All

https://launchpad.support.sap.com/#/notes/2878517
https://launchpad.support.sap.com/#/notes/2878484
https://launchpad.support.sap.com/#/notes/2859177
https://launchpad.support.sap.com/#/notes/2866114
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Platform & Extensibility PL02 Update

Feature Description Localization

MS SQL Server 2019 SAP Business One supports Microsoft SQL Server 2019

SAP Note 2877473 (PL02)

All

Service Layer:

Supports SQL View Exposure

Service Layer on Microsoft SQL can discover and expose regular 

customized SQL views in OData V3/V4 protocol

SAP Note 2912563 (PL02)

All

Service Layer:

Configuration Controller

Configuration Controller for Service Layer is available, providing a user-

friendly interface to update configuration parameters.

SAP Note 2912506 (PL02)

All

API Gateway API Gateway is available to access business data with a unified service 

endpoint, providing a one-time authentication to access Crystal Reports. 

SAP Note 2890290 (PL02)

See What’s New in SAP Business One 10.0

All

SAP Crystal Reports 2016 SP7 SAP Crystal Reports 2016 SP7, version for the SAP Business One 

application is available

SAP Note 2584094 (PL02)

All

https://launchpad.support.sap.com/#/notes/2877473
https://launchpad.support.sap.com/#/notes/2912563
https://launchpad.support.sap.com/#/notes/2912506
https://launchpad.support.sap.com/#/notes/2890290
https://help.sap.com/doc/1e4d3a635ae2433597e22263e3b2c8f4/10.0/en-US/Whats_New_EN.pdf
https://launchpad.support.sap.com/#/notes/2584094
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Platform & Extensibility FP2008 Update

Feature Description Localization

Linking UDF on UDT to System 

Objects and UDO

An UDF on a system form can be linked to a system form, user-defined 

table (UDT), or a user-defined object (UDO).

SAP Note 2949633 (FP2008)

All

Service Layer and DI API:

More Properties in SalesPersons

Object for Sales Employee Exposed

The following properties of the SalesPersons object (database table 

OSLP) are available in the DI API and Service Layer:

- Telephone

- Mobil

- Fax

- Email

SAP Note 2932743 (FP2008)

All

SAP Business One Studio Suite 

Supports Microsoft Visual Studio 

2017 and 2019

SAP Business One Studio Suite supports Microsoft Visual Studio 2017 

and 2019

SAP Note 2936980 (FP2008)

All

https://launchpad.support.sap.com/#/notes/2949633
https://launchpad.support.sap.com/#/notes/2932743
https://launchpad.support.sap.com/#/notes/2936980
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Platform & Extensibility FP2011 Update

Feature Description Localization

Security Certificates Enhancements 

for Lightweight Extensions

Trusted certificate for add-ons running in the landscape is needed. The 

add-on security mechanism will verify registered add-ons. 

SAP Note 2979022 (FP2011)

All

Service Layer:

GetAddressFormat and 

GetFullAddress Exposed

In the Service Layer GetAddressFormat and GetFullAddress exposed as 

new AddressService.

SAP Note 2990130 (FP2011)

All

Service Layer:

Supports SQL Query

The Service Layer on Microsoft SQL Server and SAP HANA supports SQL 

Query to enhance the query capability of the Service Layer and to reduce 

manual effort to deploy views.

SAP Note 2970896 (FP2011)

All

Service Layer:

JavaScript Extension Works with 

oData Version 4.0

JavaScript Extension works with oData Version 4.0 in Service Layer. 

SAP Note 2959007 (FP2011)

All

Service Layer and DI API:

Holiday Dates Exposed

Holiday date objects are exposed through Service Layer and DI API. 

SAP Note 2970998 (FP2011)

All

https://launchpad.support.sap.com/#/notes/2979022
https://launchpad.support.sap.com/#/notes/2990130
https://launchpad.support.sap.com/#/notes/2970896
https://launchpad.support.sap.com/#/notes/2959007
https://launchpad.support.sap.com/#/notes/2970998
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Platform & Extensibility FP2011 Update

Feature Description Localization

DI API:

Insert Rows at any Place in 

Production Order

Insert rows at any place within the Production Order grid via the DI API. 

SAP Note 2985713 (FP2011)

All

DI API:

License Check Function Exposed

SBObob.GetLicenseStatus is exposed on the DI API to be able to find out 

whether a user has a license to access a form.

SAP Note 2970960 (FP2011)

All

https://launchpad.support.sap.com/#/notes/2985713
https://launchpad.support.sap.com/#/notes/2970960
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Platform & Extensibility FP2102 Update

Feature Description Localization

Set Default Layouts for 

Documents/Reports and Printing 

Sequences in Report and Layout 

Manager

The report and layout manager has been enhanced to set the following 

defaults directly in the report and layout manager:

- Set default layouts for each type of document/report  

- Set default layouts for printing sequences 

- Set a system layout as inactive

SAP Note 3024856 (FP2102)

All

Service Layer and DI API:

Support UserSign of Documents

The UserSign property is available to identify documents based on the 

user who created them. This allows to filter and search for documents 

based on the creator.

SAP Note 3003222 (FP2102)

All

Service Layer:

Query Supports User-Defined Tables 

(UDTs)

The Service Layer SQL Queries supports User-Defined Tables (UDTs).

SAP Note 3009505 (FP2102)

All

User-Defined Fields Link to Sales 

Persons (OSLP)

When creating User-Defined Fields (UDFs), the Linked to Entities function 

can be used to link the UDF to Sales Persons (DB table: OSLP).

SAP Note 3003178 (FP2102)

All

https://launchpad.support.sap.com/#/notes/3024856
https://launchpad.support.sap.com/#/notes/3003222
https://launchpad.support.sap.com/#/notes/3009505
https://launchpad.support.sap.com/#/notes/3003178
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Feature Description Localization

Retrieve Current Logged User in User 

Query

In the SQL statement of an SAP Business One user query a new 

parameter $[USER] is available which reads out the ID of the current 

logged user. This parameter can be used to track the current user.

SAP Note 3009652 (FP2102)

All

https://launchpad.support.sap.com/#/notes/3009652


Thank you.
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